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Introduction to the CCM Repository 
Administrative Manual 

The CCM Repository is a model development and document management system. The CCM 

Repository is developed to support the development of ITP Microsoft Word Models.  

In this manual common administrative tasks and configuration of the CCM Repository are 

discussed. 

Chapter The administrative account (page 6) explains the built-in administrative account and what 

to do if you have lost the password for it. 

Steps to be taken after installation of the CCM Repository can be found in chapter After installation 

(page 8). 

Chapter Administrative tasks (page 15) presents more detailed information about the specific 

administrator tasks. 

The configuration files of both the CCM Repository Server and the CCM Repository Client can be 

edited by hand for fine-tuning or changing the configuration. Chapter Configuration (page 25) 

describes the options and settings of these configuration files. 

The administrator of the CCM Repository has a slightly different menu than the other users. 

Chapter Administrator menus (page 30) describes the different menu items available to the 

administrator. 

Chapter Administrator tools (page 33) provides an overview of the different tools available to the 

administrator. 

In the CCM Repository user accounts can be given different roles. These roles list the actions that 

the role gives access to. Chapter Appendix (page 38) provides information about those actions that 

are not menu items. 

 
 

Other manuals 

You can find a general user's guide in the ITPMDKRepository_Manual.pdf, which is presented in 

the CCM Repository Client Start menu. For information on how to write your own reports on the 

CCM Repository, or adapt existing ones, check the ITPMDKRepository-Reports_Manual.pdf. The 

Text Block editor, ITP/Model Development Kit, (Q)Form Editor and configuration window come 

with an Help file. 

All documentation can also be found on the Kofax Customer Communications Manager 

Knowledge Center (http://ccmkc.kofax.com). 
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Copyrights and trademarks 

© 1993–2016 Lexmark. All rights reserved. 

THIS SOFTWARE CONTAINS CONFIDENTIAL INFORMATION AND TRADE SECRETS OF 

KOFAX. USE, DISCLOSURE OR REPRODUCTION IS PROHIBITED WITHOUT THE PRIOR 

EXPRESS WRITTEN PERMISSION OF KOFAX. 

Kofax, the Kofax logo, and the Kofax product names stated herein are trademarks or registered 

trademarks of Kofax in the U.S. and other countries. All other trademarks are the trademarks or 

registered trademarks of their respective owners. 

U.S. Government Rights Commercial software. Government users are subject to the Kofax standard 

license agreement and applicable provisions of the FAR and its supplements. 

You agree that you do not intend to and will not, directly or indirectly, export or transmit the 

Software or related documentation and technical data to any country to which such export or 

transmission is restricted by any applicable U.S. regulation or statute, without the prior written 

consent, if required, of the Bureau of Export Administration of the U.S. Department of Commerce, 

or such other governmental entity as may have jurisdiction over such export or transmission. You 

represent and warrant that you are not located in, under the control of, or a national or resident of 

any such country. 

DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, 

REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, 

ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE 

LEGALLY INVALID. 

 



 The administrative account 

 

 

Kofax Customer Communications Manager Administrative Manual CCM Repository 5.0 6 
 

The administrative account 

The CCM Repository has a special, built-in user account for administrative purposes, called ITP 

Admin. This special user has some privileges that are not normally available to the other, common 

user accounts. These include: 

 Entering and reviewing CCM Repository licenses. 

 Viewing, and possibly terminating, active user sessions. 

 Managing user accounts, roles and global user authorization. 

 Breaking users' locks. 

 Setting some installation properties. 

 Purging deleted items from the database. 

On the other hand, the ITP Admin account cannot perform common model development or other 

primary tasks. 

The ITP Admin account, and user sessions of the ITP Admin account, do not count against the 

number of users mentioned in the license. This implies that ITP Admin can also log in if the license 

is violated, which is needed to be able to enter a new license. 

Other users can be granted the 'Allow login as Admin' right (on the Authorisation tab of the 

Configuration dialog of the user account). These users will then be able to login as administrator 

via the File menu. If they do so, they will have the same rights ITP Admin has, without their 

normal privileges. Note that such a user session does not count against the license. 

Versions prior to 4.2.1 do not support ITP Admin rights for other user accounts. 
 

Password 

The built-in ITP Admin user account has the default built-in password www.aia-itp.com. For 

security reasons, the CCM Repository will force you to change this password when you first log in 

as ITP Admin. 
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I forgot the password 

If the password to the ITP Admin account is lost you can use another user account with 

administrative rights to reset the ITP Admin password. If no user account is configured with 

administrative rights you will need a more drastic way to reset the password. 

It is possible to have the CCM Repository regenerate the default password. To do this, you need 

access to the CCM Repository database, and you need a tool to execute SQL commands against 

that database. 
 

Method 1 

Enter and execute the following SQL statement: 

DELETE FROM T1200 WHERE C1201=1 

This will remove the ITP Admin account. 

Locate the cvc.exe program that is installed in the program folder of the CCM Repository Server, 

either using the Windows Explorer or the command line. Now restart the CCM Repository Server 

and run the cvc.exe program within 10 seconds after starting the server. This will regenerate the 

ITP Admin account. After the cvc program has finished, start an CCM Repository Client and log in 

again as ITP Admin with the default password. You will again be prompted to change the 

password. 
 

Method 2 

Alternatively, you can also execute the following SQL statement: 

UPDATE T1200 SET C1203='WxznduXnvZCsW6tArBO+0g==', C1207=NULL WHERE C1201=1 

This will reset the password to its default value. Take care to copy the command exactly as shown. 
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After installation 

This section is mainly of interest after a fresh install of the CCM Repository. If you performed an 

upgrade of an existing CCM Repository system, you probably already performed the steps 

mentioned here. 

Warning 

Please be aware that the database attached to CCM Repository contains important 

production data. Make sure that it is backed up on a regular basis.  

When you have installed the CCM Repository you need to perform the following steps. Not all of 

them are mandatory, and can be postponed to a convenient moment, when you want to configure 

the CCM Repository to match your needs more closely. 
 

Enter licenses 

To make the CCM Repository fully functional, you need to enter the licenses that you have 

obtained. 

Login in as ITP Admin, with the default password (www.aia-itp.com). You will be prompted to 

change the password. Make sure to remember this password. 



 After installation 

 

 

Kofax Customer Communications Manager Administrative Manual CCM Repository 5.0 9 
 

Select License... from the View menu. Click the button Edit to enter the license information for the 

Base license, the Model development license, and the Text Block editing license in turn. The DID 

development (SDK/MP) license is only needed if you want to develop DIDs in the CCM 

Repository. 

 

The Model development license and Text Block editing license come with a number of users. These 

indicate the number of user accounts and simultaneous user sessions that are allowed for model 

development and Text Block editing, respectively. 
 

Create user accounts 

The built-in ITP Admin account is for administrative purposes only, and cannot participate in 

model development or other common CCM Repository tasks. You need to create one or more user 

accounts for this. After selecting the  folder Users you can choose the option New user... from the 
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File or context menu. Enter a user name and password, which the user will need to log in. Also 

enter the full name. 

 

At least one user account will need the right to create projects and assign authorization to users. To 

accomplish this, select the Users node in the tree view, and double-click the user on the right who 

you want to give this authorization. Alternatively, select Configuration... from the shortcut 

menu on that user. 

 

Select the Authorization tab in the ensuing Configuration dialog, and mark the Project 

Creator role in the Global Roles panel. Click OK to close the dialog and save the changes. 

The check box 'Allow login as Admin' will, if checked, allow the user to log in with the same rights 

as ITP Admin. The user can do so with the 'Log in as Administrator' option on the File menu to 

explicitly request this behavior. 
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Versions prior to 4.2.1 do not support ITP Admin rights for other user accounts. 
 

Set document template 

The next thing you need to do is install the Repository.dot template. This template will provide 

users with the ITP styles in their ITP/Model Development Kit. The function of this template is 

discussed elsewhere. 
 

The Repository.dot template is only provided in the Extra folder in the install folder of the CCM 

Repository Server. It needs to be copied to the file system and the administrator must configure the 

path to it in the CCM Repository. This template contains the ITP styles and you are free to edit (a 

copy of) it. We recommend using the ITP styles but apart from that feel free to adjust the template 

to your needs. 
 

Copy repository.dot to the file system 

The Document Template is called repository.dot. It must be copied to a location on the network 

that is accessible to all CCM Repository Clients. If you already use an ITP template for all ITP users 

on your network this step can be omitted. 
 

Set the path to the repository.dot 

After the template has been copied, the path to it needs to be set in the CCM Repository. The item 

Change Document Template… in the Action menu of the administrator offers you a file select 

window in which the template can be located and selected. 

 

Note that only the path is stored in the CCM Repository, not the template itself. 
 

Using your own template 

If you already use an ITP template on your network, you can set the path to it to keep using it. 

Only .dot files are accepted and a content check will be performed on the selected template. 
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Note  

The template will be used for new documents. It has no effect on existing documents. 

Note  

Any user of the CCM Repository can edit the repository.dot template. To prevent users 

from editing the template make it read only. 

 

Set CCM Repository role 

This step can be omitted if you are only using a single CCM Repository in your organization, or 

you do not plan to export (parts of) your projects to other CCM Repository installations. 
 

Purpose 

The CCM Repository supports and encourages separation of development steps, e.g., 

Development, Test, Acceptance, and Production into several CCM Repository installations. The 

role, or purpose, of such an CCM Repository installation can be configured in that installation, so 

that the CCM Repository Client can clearly show to the user with which installation he is currently 

working. Furthermore, objects and revisions that are exchanged between several such installations 

hereby can clearly show their origin. 
 

Configuration 

Select Installation properties from the Action menu. In the following dialog, provide the following 

information: 
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After filling in the desired fields, click OK. If you changed the revision number postfix, a dialog box 

will pop up asking you whether you want to apply the new postfix to all existing revisions. 

 

Click Yes to have all existing revision get the new postfix, No if you want existing revisions to keep 

the postfix they already had. In a new installation, there are no revisions that are eligible for getting 

a postfix, so the choice will not matter in that case. 

 
 

Revision number postfix: 

Enter a very short (several characters) text here, that briefly describes the role of the CCM 

Repository installation. This may for instance be 'dev' or 'prd' for development or production 

repositories. This short text will be put behind every revision number of revisions created in this 

installation, yielding revision numbers like '1.2 prd'. This helps identifying the origin of revisions 

that are exported and imported into another installation. 

 

 
 

CCM Repository role: 

Essentially conveying the same information as the revision number postfix, this field contains a 

longer representation of the purpose of the CCM Repository installation. Enter e.g., 'Development' 

for a development installation. This text will be displayed in the status bar of all CCM Repository 

Client windows. 

 
 

CCM Repository role signaling color: 

Under circumstances that a user has access to several CCM Repository installations, and it is 

important that he is always aware of which installation he is working with, the signaling color can 

give some extra visual feedback. The color selected here will be used as background color of the 

part of the status bar that displays the CCM Repository role name. It can e.g., be used to warn the 
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user that he is working in the production installation, to make him extra careful. 

Selecting a signaling color is optional. 
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Administrative tasks 

This section lists the tasks specific to the users with administrative rights or the ITP Admin user 

account. 

When the CCM Repository logs in to the CCM Repository the following special Administrator 

folders are shown: 

 Users 

 Roles 

 Audit log entries 

 

These folders contain information and objects specific to the administrator. They will be addressed 

below, where applicable. 
 

User management 

Only ITP Admin or a user with administrative rights may create, delete or change user accounts. 

The user accounts can be found in the folder Users at the same level as the Projects folder. Only 

administrators have access to this folder. 
 

Managing 

The administrator can create new user accounts, and rename and delete existing ones. A user 

account has a login name, a password and a full name. The latter is used for identification 

purposes. 

Note  

If spaces are the only differences in names, they are considered to be the same. It is not 

possible to have users with the same name.  

 

Unified logon 

Normally the CCM Repository Client will prompt the user for his name and password when 

starting. Optionally `unified logon´ (also known as 'single sign-on') can be used. In that case the 

user name of the Microsoft Windows account, with which the user is logged on to Microsoft 

Windows, is also used to log on to the CCM Repository. This logon is performed automatically 

when the CCM Repository Client starts. In this case the password of the user is not used. To avoid 

that a local Microsoft Windows user inadvertently gains access, it is checked that the user name on 
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the client maps to the same account as on the server. 

To use unified logon, user accounts must still be created in the CCM Repository. The names of 

these accounts must match those of the Microsoft Windows user accounts. Also the CCM 

Repository Server must be configured to allow unified logon. Add: 

[Configuration] 

AllowUnifiedLogon=Y 

to the servers' itprep.ini file, as explained in the section Configuration (page 25). Contrary to most 

settings, you don't need to restart the CCM Repository Server after changing it. 

When the CCM Repository Server is configured to use unified logon, it is still possible to force 

individual CCM Repository Clients to ask the user explicitly to login. You can do this by starting 

the CCM Repository Client with the `/asklogin ´ flag, or by adding the following line to the 

clients' itprep.ini file: 

[Configuration] 

Asklogin=Y 

When you are already logged in into the CCM Repository Client you can easily switch to another 

user by choosing: 

File > Switch user 

Note 

If you choose to switch to another user, your rights will also change. 

 

Create a user account 

The administrator can add a new user, by selecting New > New User... from the File or context 

menu, or by clicking the button with the + sign  on the toolbar and select New User.... The 

window New User... is opened: 

 

Enter a user name and password, which the user will use to log in to his account. Also provide a 



 Administrative tasks 

 

 

Kofax Customer Communications Manager Administrative Manual CCM Repository 5.0 17 
 

full name, identifying the user. The password must be at least six characters long. 
 

Rename a user account 

The administrator can change a user's login name. 

Right-click on the user and select Rename or click on the users name and click again or press F2. 

The name will stay selected, a box will appear around the name and the cursor is positioned at the 

end of the name. 
 

Select the Users node in the tree view and find the user account in the details pane. Select the 

Configuration... menu option from the context menu of a user account, or double-click the 

user account. The Configuration dialog shows up. 

 

On the tab General the login name and full name of the user account can be changed. 
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Authorize a user account 

Select the Users node in the tree view and find the user account in the details pane. Select the 

Configuration... menu option on the context menu of a user account, or double-click the user 

account. The Configuration dialog shows up. 

The authorization of the user can be changed on the tab Authorization. This can be done by 

selecting or de-selecting roles in the Global roles panel. (Roles are described below.) To be 

able to create new projects, at least one user must have Project Creator authorization on global 

level, i.e., configured on the user account itself. 

 

Note that roles assigned to the user account here are global, meaning that the user account has 

these roles for all projects in the CCM Repository installation. More fine-grained authorization can 

also be managed by non-administrative users with the proper authorization (e.g., Project Creator 

or Project Manager), allowing users to receive authorization for a specific project, folder or even 

document. When a user is not authorized for a specific folder or object, he will not see this 

information. This way it is possible to hide irrelevant folders and objects, e.g., for users that only 

have right to use the Text Block editor. Refer to the CCM Repository Manual, section Roles and 

Authorization for more information.  

The check box 'Allow login as Admin' will, if checked, allow the user to log in with the same rights 

as ITP Admin. The user can do so with the 'Log in as Administrator' option on the File menu to 

explicitly request this behavior. 

Versions prior to 4.2.1 do not support ITP Admin rights for other user accounts. 

Note 

The user whose authorization has been changed must log out and log on again for the 

change to take full effect. 

 

Change a user's password 

A user can change his own password. In case this password is lost, the administrator can reset the 

password of other users. 
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Select the Users node in the tree view and find the user account in the details pane. Select the 

menu option Change user password... on the shortcut menu of a user account. The Change 

user password dialog shows up. 

Enter the new password twice, to prevent typing errors. Note that you do not have to enter the old 

(possibly lost) password. 

 
 

Delete a user's account 

Select the Users node in the tree view and find the user account in the details pane. Click the 

button Delete , or select Delete from the shortcut menu of the user account to delete it. You will 

be asked to confirm deletion. 

Deleting a user will not immediately remove it entirely. Instead, the user account is marked for 

deletion. This implies that the user account cannot be used anymore to log into the CCM 

Repository. It will also no more count against the maximum number of users in the license. 

However, the account stays available as reference information. e.g., models created by this user 

account will still list this user account in the column 'created by', provided that the View option 

Show deleted items is turned on. 
 



 Administrative tasks 

 

 

Kofax Customer Communications Manager Administrative Manual CCM Repository 5.0 20 
 

Manage user sessions 

The Sessions... option in the View menu displays a list of currently active user sessions. The 

administrator may elect to close a user session from this window, e.g., if that user session appears 

to hang. 

 
 

Role management 

What is a Role 

The CCM Repository uses a role-based authorization mechanism. In this, a user is assigned a 

number of roles, either globally, or in the context of a specific project, folder or document. A role 

consists of a listing of actions that the user is allowed to perform, if he has this role. These actions 

largely coincide with the menu actions that the CCM Repository provides. A few represent specific 

tabs in the Configuration dialog, thereby allowing authorization to be applied to e.g., project 

configuration or authorization itself. 
 

Predefined roles 

The CCM Repository creates a few standard roles upon installation. Normally, these standard roles 

should be sufficient for most purposes, thereby avoiding the need to create custom roles. 

These predefined roles can be changed or deleted. 
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Creating or editing roles 

Only the administrator can change or create a role. To create a new role, select New > New role... 

from the File or context menu. To edit an existing role, select the Roles node in the tree view and 

double-click the role to edit. Alternatively, select Edit role... from the context menu of the role. 

Check the actions that you want to include in the role. 

 

The appendix contains a list of selectable actions. 
 

Lock breaking 

A document, model, and so on, can be locked by a user. Normally, only that user can unlock the 

object again. If needed, also the administrator can break a lock on an object. Contrary to the normal 

case, the [in development] revision of the object is not made the [current] revision, if the lock is 

broken. 
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Break a lock on a specific object 

Locate the object in the tree view or details pane. In the context menu of the object, select Break 

lock... The lock will be removed from the object. If this Break lock... action is selected on a 

folder or project, the CCM Repository will ask for the user whose lock should be broken. The locks 

of all objects in that folder, that are locked by that user, will be broken. 

 
 

Break all locks of a user 

Select the Users node in the tree view, and select Break lock... in the context menu of the user 

account in the details view. All objects in the entire CCM Repository installation, locked by this 

user, will be unlocked. 
 

Purging deleted items 

Clients can delete objects. This does not mean that they actually get removed at that moment. 

Instead, they are marked as deleted, and hidden from the normal view. (The menu item View | 

Show Deleted Items displays them again.) Objects marked for deletetion can be actually removed 

by choosing Purge from the File menu. Purging means that all removable items are deleted from 

the database. Purging is irreversible. Once an item has been purged, it cannot be recovered, except 

perhaps via external means such as a backup of the underlying database. To avoid that clients 

purge items by mistake, only the administrator is allowed to do this. 

Purging will not necessarily remove all objects that are marked for deletion. Items that are 

somehow marked as 'useful' by the CCM Repository will not be removed. This is for example the 

case when a user deletes a source document, but not the model that has been created from it. The 

source document will not be purged until the model itself gets deleted too. The exact reasons for 

not purging an item can be rather intricate, so we will not elaborate on them here.  

The Administrator, however, has a special sub node 'purging blocked by' that lists the objects that 

would prevent the revision from being purged. It may either be used by these objects, or be 
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configured in them (in case of folders and projects). The administrator can see this node under 

revisions and base objects marked for deletion, if he has enabled the option Show Deleted Items in 

the menu View. 

Note  

Every revision of a document is a complete version of that document, taking up the 

same amount of disk space as the original document. Deleting a revision and purging 

will delete that revision from the database and free up some space. 

 

Audit log 

An audit log entry is used to log some events that may be of interest to an administrator, such as 

failed login attempts. It can be viewed by selecting Audit log entries in the tree view. 
 

Licenses 

Only ITP Admin can enter the licenses. Refer to the Enter licenses (page 8) for details. 
 

Set document template 

ITP Admin or a user with administrative rights can set the global document template. Refer to Set 

document template (page 11) for details. 
 

Set CCM Repository role 

ITP Admin or a user with administrative privileges can set the CCM Repository role. Refer to Set 

CCM Repository role (page 12) for details. 
 

Handle accepted revisions as published 

Version 3.5.10 of the CCM Repository introduced the status [published] for object revisions. This 

status is used by default to determine which revisions of dynamic objects are used in a model run. 

A compatibility option "Handle accepted revisions as published" was also introduced. If this option 

is set, the CCM Repository reverts to its previous behavior of returning [accepted] revisions for 

dynamic objects, instead of revisions with the new [published] status. This allows customers that 

already are using the [accepted] status in their processes and configuration to postpone the 

transition to using the [published] status. When a pre-3.5.10 version is upgraded, this option is 

turned on. New installations will have the option turned off.  

Note 

Do not to turn on the option when the status [published] on objects is already 

introduced. In this case, the runtime behavior of which revision will be selected for the 

production run is not defined. 

The dialog under the Installation properties menu allows you to change the value of this option. 

The CCM Repository Server and Clients have to be restarted to make the change fully effective. 
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Note 

The checked option "Handle Accepted revisions as Published revisions" even takes 

charge if CCM Core is configured to select runtime objects with the status published 

from the CCM Repository. Refer to the topic about the General tab in the 

Administrator's Help for more information about the configuration setting that can be 

used to set the status of the runtime objects that are retrieved from the CCM Repository, 

i.e., RepositoryObjectStatus. 
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Configuration 

General 

Both the CCM Repository Server as the CCM Repository Client uses a configuration file that can be 

used to do some extra configuration. 

Settings are stored in the file itprep.ini. The client and the server have their own ini file. These files 

are located in the CCM Repository folders of respectively the client and the server. They can be 

edited with any text-editor. 

Note 

There are (at least) two itprep.inis: one for the server and one for each client. 

Note 

The configuration files are only read at start-up. Ergo: 

Restart the CCM Repository on the client after you have edited the client configuration 

file. 

Restart the CCM Repository Server if you have edited the server configuration file. 

In normal circumstances, the configuration file is filled correctly and sufficiently by the installer 

program. Some fine-tuning, or changing configuration later, can be done by hand. Edit the 

configuration file in a plain text editor, such as Notepad. 

Below, the example values given are the default values. 
 

Syntax 

Ini file sections 

Options and settings are arranged in sections in the configuration file. 

A section starts with the section name in square brackets on a separate line: 

[Configuration] 

Settings are added in 'Name=value' format. 

Note  

Not all settings are present in the ini file created at installation. If a setting is not present 

in the ini file it is set to its default. 

 

Comment 

A ; (semicolon) can be used to comment out a line in the configuration file. It must be the first 

character on a line. 
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Shared configuration 

The following configuration options are valid for both client and server. 
 

[Configuration] 

logfile = itprep.log 

logsize = 10485760 

logrotate = 10 

These set logging options. Relevant information is logged to the file specified by the log file setting. 

With the logrotate setting it is possible to determine how many 'old' log files are kept (renamed to 

itprep.log.1, itprep.log.2 etcetera). A new log file is created every time the CCM Repository starts 

or when the size of the log file exceeds the value in bytes set with the logsize option. 

language = eng 

The screen language. Select 'eng' for English or 'nld' for Dutch. Default is English. For the client, 

this setting can be changed by using the Language item in the View menu. (This will only fully 

take effect after a restart of the CCM Repository client). 

temppath = %TMP% 

The folder where the CCM Repository will put temporary files. Defaults to the temp folder 

specified by Microsoft Windows. Another path can be specified as c:\ <some dir>. The CCM 

Repository extensively uses the temp folder. This means that there must be enough disk space 

available to the temp folder. 
 

Server configuration 

All required settings are configured during installation. If you do need to edit the configuration file 

there is an entry in the Microsoft Windows Start menu under Programs\CCM Repository Server 

called Edit Configuration, which will give you access to the server configuration file. 

Note 

Restart the CCM Repository after editing the ini file. 

 

[Server] 

In this section the port number is set used by the server to listen for requests. 

2586 is the default value. Any port number below 65536 is valid. 

[Server] 

port=2586 

host=<server name or IP address> 

The 'host' value is not actually used by the CCM Repository server. It is added to the configuration 

file by the installer on behalf of other CCM Repository programs that may use the same 

configuration file. 
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Unified logon 

Setting 

[Configuration] 

AllowUnifiedLogon=Y 

in this section will allow the CCM Repository Client to log on the user using the Microsoft 

Windows' user account name. Without it, users will have to provide their user name and 

password. 
 

Licenses 

There are three license sections: [Base license], [Model development license], and [Text Block 

development license]. Normally, these are to be filled via the CCM Repository Client, by logging in 

as ITP Admin and selecting License... from the View menu. 

The following keys occur for each of the three license sections. The values are provided by Aia 

Software on the license certificate. Please copy these verbatim. 

company= 

Given on the license certificate. 

certificate= 

Given on the license certificate. 

environment= 

Given on the license certificate. 

date= 

The expiration date for the license as found on the license certificate. Format: yyyymmdd 

users= 

This settings stands for the maximum number of users that can be created and be connected to the 

server at the same time. This number can be found on the license certificate. The administrator is 

not considered to be a user in terms of the license. For the base license, this value is 1. 

key= 

Given on the license certificate. Please copy verbatim. 
 

[ODBC] 

In this section the connection with the database is configured. The Connection String entry is set at 

installation. 

connString = <connection string> 

The connection string specifies the ODBC driver to use, the database to connect to, and various 

database options. Refer to the documentation of your database management system for more 
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information. 

Alternatively, provide a Data Source Name. 

DSN = <data source name> 

The data source name for the database that is to store the CCM Repository data. 

user = <user to connect to the ODBC DSN> 

password = <password to connect to the ODBC DSN> 

User and password are provided as separate settings. They do not need to be included in the 

connection string. This allows for encryption of the password in th configuration file. 

If the password is present in the configuration file in plain text it will be encrypted the first time it 

is used, i.e., as soon as a connection with the database is created. You can recognize the encrypted 

password by its 'encrypted:' prefix. It is not possible to decrypt the password. If you want to 

change the database password in the configuration file replace the 'encrypted:' string with the new 

plain-text password. The CCM Repository will again encrypt the new password on the first run. 

Note 

Use a non-expiring password for the account used to connect to the database, especially 

when you use Client Access, because the Service used by the CCM Repository cannot 

become interactive. This means that when the connection tries to tell you that the 

password will expire, the CCM Repository will show an error and you will not be able to 

connect. 

 

[Network] 

This setting can be used to reduce the size of the packages sent over the network. This setting may 

be 

used if network load errors occur (which are signalled by error code 10055). 

msgsize= <packet size in kilobytes> 

If network load errors occur our advice is to start with a package size of 64 KB, if the problems still 

occur step back to 32, 16, etcetera. The default packet size limit is 512 KB. 

Note 

This setting must also be added to any client connecting to the CCM Repository server 

whose ini file you are editing. 

Restart the CCM Repository after editing the ini file. 
 

Time-outs 

The time the CCM Repository takes for analyzing documents and compiling Master Templates is 

limited to respectively 1 minute and 15 minutes. Extremely large or complex documents may 

therefore encounter a timeout. These limits can be configured in the itprep.ini file of the CCM 

Repository service: 
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[ITP] 

ConversionTimeout=60 

CompilationTimeout=900 

(Values shown are defaults.) 

Increment the CompilationTimeout value if you encounter the message 'crtmdl timed out'. 

Increment the ConversionTimeout value if you encounter one of the messages: 'idoc2unc timed 

out', 'Generation timed out', or 'Analysis timed out'. 

The CCM Repository server must be restarted for these changes to have effect. 
 

Client configuration 

All required settings are configured during installation. 

Close and restart the CCM Repository Client after editing the ini file. 
 

[server] 

This section contains the settings used to connect to the CCM Repository Server and contains 2 

settings: host and port. 

[Configuration] 

port=2586 

host=<server name or IP address> 

The default value for 'host' is localhost. It indicates the computer on which the CCM Repository 

server is running. 

'Port' is the TCP/IP port number used by the CCM Repository to send its requests to the CCM 

Repository Server. This port number should match the 'port' valueis set in the [Server] setting of 

the CCM Repository Server ini file. 
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Administrator menus 

Administrator File menu 

The Administrator sees a different File menu from the users. His menu is geared to 

administrative tasks. The following menu items are only available to the Administrator. 
 

New 

New user 

Creates a new user. The window New User... pops up. In the window New User... you must 

enter: 

User name, which may have a maximum length of 254 characters. This will be the login name of 

the user. It will be most used in the CCM Repository so our advice is to enter something legible 

and meaningful. 

Note 

If spaces are the only differences in names, they are considered to be the same. It is not 

possible to have users with the same name. 

Full name, which may have a maximum length of 79 characters. This name must be meaningful to 

you as user administrator because you will need it to identify users. 

Password, which must have a minimum length of six characters. Enter a password of at least six 

characters and confirm in the confirm text box. This password in combination with the user name 

must be unique to the CCM Repository. 

Notes 

Every user, when authorized to do so, can change his own password; the administrator 

can reset all users passwords. 

The administrator can change the login name and/or the full name of a user in that 

user's configuration window. 

 

New role 

Creates a new role. The new role window pops up. 

Roles are the way in which authorization is managed in the CCM Repository. Each role is a bundle 

of permissions. You can select the permissions you want to be part of a role in the new role 

window. Help is available in the New role window. 
 

Edit role 

Opens a window in which Roles can be edited. Roles are the way in which authorizations are 

organized. Each role is a bundle of authorizations. In this window the specific authorizations of a 

role can be changed. Help is available in this window. 
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Purge 

Selecting Purge will attempt to remove all objects from the database that are marked for deletion. 

Objects will not be deleted if they are somehow used by others that are not marked for deletion. 
 

Cleanup project 

This menu item comes available when a project is selected in the tree view. It allows the 

Administrator to free up disk space by deleting document revisions and labels from the selected 

project. The revisions are marked for deletion and can be restored, but labels are removed 

permanently. To permanently delete the labels, run the Purge command. 

Note 

We advice to back up your data before a clean up. 

Help is available in the Cleanup window. 
 

Administrator Action menu 

The following items are only available to the administrator in the Action menu. 
 

Break lock 

If a user edits a document that document is locked. This means that no one else can edit this 

document. To prevent deadlocks an administrator can break all locks. When he does the in 

development revisions of the locking users will be turned into revisions but the current revision 

will remain the same. In other words work is saved but the current marker is not moved to it. This 

means that if a document is edited after its lock has been broken the revision before last (the 

current revision when it was locked) will be opened. This menu item is only available to the 

administrator. 
 

Change user password 

It opens the window Change user password <selected user>. A password of a specific user 

can be altered by selecting the user under Users in the tree view and selecting this menu item or 

by right-clicking on that user and choosing Change user password. The new password must be 

entered twice. A password must be at least six positions long. 

Only ITP Admin or users with adminstrative rights are allowed change the passwords of all users. 
 

Change Document Template 

With this item the path to the Document template used by the ITP/Model Development Kit to 

create documents can be set in the CCM Repository. Any template file can be selected. With the 

CCM Repository Server installation the template repository.dot is placed in the install folder. We 

recommend using this template to start with because it contains the ITP/Model Development Kit 

Style bar. It can be altered as you see fit. The template needs to be copied to a network location 

accessible for all CCM Repository Clients before a path to it is set. 

When a path is set only dot files are accepted and some content checking is performed. 

Note 

The file is not stored in the CCM Repository, only the path to it is. 
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Note 

By default no path is set and all new documents are therefore based on the local 

'normal.dot' of the client. 

 

Installation properties 

This action displays a dialog allowing you to set some system-wide properties of the CCM 

Repository installation. This includes: 

 The revision number postfix and other identifying information. Refer to Set CCM Repository 

role (page 12) for more information. 

 The compatibility option "Handle accepted revisions as published". Refer to Handle accepted 

revisions as published (page 23) for more information. 
 

Administrator Report menu 

The reports described in this chapter are all available reports. The Report menu allows you to 

generate reports of the content of the CCM Repository. These reports are implemented as ITP 

models. There are a number of predefined reports made with models that can be viewed in the 

project Repository Reports. All of these objects are owned by Aia. This means that you can create 

revision for them but you cannot delete them. You can however add your own reports. When you 

do they will appear in the Reports menu when you start a new CCM Repository browser window. 

Refer to the separate reports development guide for more information. 
 

User authorization 

This is an administrator-only report. It will list all roles of a selected user in all projects. 
 

Administrator View menu 

The following items are only available to the administrator in the View menu. 
 

License... 

This menu item opens the window License information. In this window the license can be 

edited. 
 

Sessions... 

This menu item opens the window Active sessions. All current sessions are listed in this 

window by address and name. A session can be terminated by selecting it and clicking the button 

Disconnect. 

This feature can be used to free sessions of crashed clients. 
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Administrator tools 

Repdump/repload 

It is also possible to write the complete CCM Repository database to a file. This is done with a tool 

called repdump. To read this file in another database the tool repload is used. 

Please note that this functionality is primarily intended to be used as a means to migrate the 

database to a different DBMS. It is not intended as a document life-cycle support mechanism. It 

can, however, be used to make a safety duplicate (back-up) of the database. 

Note 

The dumping CCM Repository version must be the same as the loading CCM 

Repository version. 

 

Repdump.exe: exporting the CCM Repository database 

Repdump.exe must be run on the server that runs the CCM Repository. It is installed in the root of 

the ITP/Model Development Kit Server installation and it must not be moved since it needs the 

Server Initialisation file that is located in that folder. 

Repdump is used from the Command Line and takes just one parameter, i.e. the path/name of the 

file it will export the CCM Repository database to. If no path is provided the file will be written in 

the current folder. 

Repdump writes a log, Repdump.log that can be found in the folder it is installed in. 

Repdump "path\database dumpfile name" 

 

Repload.exe: loading an exported database 

Repload must be run on the server that runs the CCM Repository. It is installed in the root of the 

ITP/Model Development Kit Server installation and it must not be moved since it needs the Server 

Initialisation file that is located in that folder. 
 

Use of repload.exe 

Start the upload process by creating a new database or selecting an existing database that can be 

emptied and refilled. To load a file, the CCM Repository needs to be stopped. Stop the CCM 

Repository by selecting Stop server from the CCM Repository Start menu. Repload needs to 

be called from the ITP/Model Development Kit Server root folder, the folder where the 

itprep.ini is located as well. Repload takes just one parameter, the path/name of the file made with 

the Repdump tool. 

If an existing database is used the flag -cleardatabase can be used to empty the database before 

loading the file. Note that it is not possible to add the content of a CCM Repository database dump 

file to the content of an existing CCM Repository database, repload will either use an empty 

database or replace the content of an existing one. 

Note 

Using -cleardatabase means that all content in the database of the loading CCM 

Repository will be destroyed. Use with care. 
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Repload "path\dumped file name" <-cleardatabase> 

 

Repload.exe Log 

Repload will write a log with the name Repload.log in the folder it resides in. 
 

Database not empty error 

If you started a client before using repload you will encounter an error because the database is no 

longer empty. The start of a client initiates the configuration of the database rendering it not 

empty. If you do encounter that error you can use the -cleardatabase flag with repload to empty 

the database before loading. 
 

New database 

The CCM Repository can use any multi-user database that can be created and controlled with 

ODBC. 

It is also possible to change the database the CCM Repository is using. All you need is a new 

database and a connection string to connect to it. 

Please refer to the Installation Guide for information on creating a database and a connection string 

or DSN. 
 

Configure the CCM Repository 

The new database must still be configured on the CCM Repository server. Choose Edit 

Configuration from the menu item ITPMDK Repository Server in the Microsoft 

Windows Start menu. 

This will open the itprep.ini file in a text editor. 

The entry that need to be changed is the [ODBC] entry. This entry looks something like this: 

[ODBC] 

ConnString=<connection string> 

user=<db user> 

password=<db user password> 

The values after (=) must be changed. Provide a connection string for the new database after 

ConnString=. Also change the database user name and password if necessary. 

Instead of a connection string you can also create a Data Source Name for the new database and 

configure that. Use the setting: 

[ODBC] 

DSN=<data source name> 

 

Restart the Server 

The next step is to restart the Server. This is done in 2 steps: stop the Server (if not already done so) 

and start the Server. Both commands can be found in the Microsoft Windows Start menu > 

Programs > ITPMDK Repository Server. 
 

Initializing database and uploading Reports 

The final step is to prepare the database and to upload the Reports. Reports are part of the 

functionality of the CCM Repository that is implemented as a project and as such they need to be 
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uploaded to the new database.  

The cvc tool is used to do both database initialization and reports loading. 

Uploading in steps: 

 Start a command line prompt 

 Change folder to the folder where you installed the ITP/Model Development Kit Server 

 Run the following command: 

cvc reportsdump 

Note  

that you can only see reports if one of your roles allows you to. If you do not see any 

reports, or only some reports, check your authorization. 

After this step you can open a client and start working in the new database. 
 

Backups 

Be aware that the database attached to CCM Repository contains important production data. Make 

sure that it is backed up on a regular basis. 
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Interface translation table 

It is possible to set the screen language to Dutch. In order to be able to use this English manual a 

translation table of the terms used in the interface is provided below. 

 

English Dutch 

About... Info... 

Action Actie 

Authorization Autorisatie 

Break lock... Vrijmaken... 

Change Document Template... Wijzig Document Sjabloon... 

Change my password... Mijn wachtwoord wijzigen... 

Change user password... Gebruikers wachtwoord wijzigen... 

Cleanup project... Project opruimen... 

Clear Wis 

Close Sluiten 

Close browser Sluit venster 

Configuration... Configuratie... 

Configure authorization tab Configureer autorisatie tab 

Configure project tab Configureer project tab 

Configure DID/CC tab Configureer DID/CC tab 

Configure characteristics tab Configureer kenmerken tab 

Configure auto-includes tab Configureer auto-includes tab 

Configure field sets tab Configureer VeldenSets tab 

Copy Kopiëren 

Cut Knippen 

Delete Verwijderen 

Deploy... Uitrollen... 

Edit role... Wijzig rol... 

Exit Afsluiten 

File Bestand 

Help Hulp 

Language Taal 

License... Licentie... 
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English Dutch 

Locked by… Onderhanden bij… 

Login Aanmelden 

New role… Nieuwe rol… 

New user... Nieuwe gebruiker... 

Open Openen 

Paste Plakken 

Purge Definitief verwijderen 

Refresh Vernieuwen 

Report Rapport 

Restore Herstellen 

Roles Rollen 

Select Kies 

Select All Alles selecteren 

Select Document Template Selecteer Document Sjabloon 

Sessions... Sessies... 

Set description... Beschrijving wijzigen... 

Show deleted items Toon verwijderde items 

Show details Toon details 

View my changes Mijn wijzigingen bekijken 
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Appendix 

Roles list the actions that the role gives access to. Most actions are normal menu items, and are 

explained in the user's manual. The following actions, however, are not menu items, and are 

explained here. 
 

Configuration 

Permission to edit the configuration of objects in the CCM Repository. This permission gives access 

to the Configuration window of an object. 

Initially all that can be changed with this permission are the name and the description (in other 

words, the General tab of the Configuration window). The next permissions determine which 

of the other tabs of the Configuration window will be shown. 

Note 

The Configuration permission is needed for the Configure authorization, Configure 

auto-includes, Configure characteristics, Configure DID/CC, Configure field set and 

Configure project permissions. This permission implicitly allows a user to rename 

objects. 

Note  

A user whose roles have been changed must log out and log on for the change to take 

full effect. 

Note  

The General tab will be hidden for users that don't have permission to edit the tab. 

 

Configure Authorization tab 

The permission Configuration is needed for this permission to have an effect.  

Permission to assign and revoke roles. When granted this permission the Authorization tab will 

be shown in the Configuration window. A user who has this permission cannot create roles, 

nor can he change the permissions contained in a role, but he can assign users to roles in a project 

or projects. 

Note 

A user whose roles have been changed must log out and log on for the change to take 

full effect. 

Note 

The Authorization tab will be hidden for users that don't have permission to edit the 

tab. 

 

The permission Configuration is needed for this permission to have an effect.  

Permissions to add and remove Field Sets from a Forms folder or a Text Block folder. In case of a 

Forms folder also permission to add and remove Views from the Forms folder. 
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Configure Characteristics tab 

The permission Configuration is needed for this permission to have an effect.  

Permission to set characteristics for a project. This permission will show the Characteristics 

tab in the Configuration window. 

Note  

A user whose roles have been changed must log out and log on for the change to take 

full effect. 

Note  

The Characterics tab will be hidden for users that don't have permission to edit the 

tab. 

 

Configure DID/CC and Style document tabs 

The permission Configuration is needed for this permission to have an effect. Permission to set 

the DID and Connection Configuration for a project or folder as well as the Style Document. This 

permission will show the tabs DID/CC and Style Document in the configuration window of a 

project or a folder. 

Note 

A user whose roles have been changed must log out and log on for the change to take 

full effect. 

Note  

The DID/CC and Style Document tabs will be hidden for users that don't have 

permission to edit these tabs. 

 

Configure Fields Set tab 

The permission Configuration is needed for this permission to have an effect.  

Permissions to configure Field Sets on a Forms folder or Text Block folder. 
 

Configure Project tab 

The permission Configuration is needed for this permission to have an effect. This setting is the 

permission to configure a project. When this permission is granted the tab Project is visible in 

the Configuration window. 

Note 

A user whose roles have been changed must log out and log on for the change to take 

full effect. 

Note  

The Project tab will be hidden for users that don't have permission to edit the tab. 
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Cut 

Permission to move a document from one project to another. 

The permission to Paste is linked to the permission to Cut: when a user has the permission to 

Cut he can also Paste. The permission to Paste is not limited to any one project. In other words, 

a user can move a 'Cut' document to any project in the CCM Repository. 
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